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Introduction
With the introduction of Windows 8 Microsoft relies on the tiles concept for structured visualization of programs,
apps and information on the home screen. Even SAP has taken up this idea,  and with SAP Fiori, they have created
a simple user interface that is build on this tile concept - adapted to the needs of operational business applications.

It was therefore obvious for us to develop a tile solution for Business Intelligence (BI) – the more so as our
customers have signalled a demand. They wanted a start screen for dashboards that clearly represents the key
performance indicators (KPIs).

From this highly aggregated view the user should jump – in terms of a pre-defined navigation path – on graphical
overviews or detailed table views created with our  and  – see Figure below –graphomate charts graphomate tables
from starting point to detail

After a first gathering of the customer requirements pertaining to a tile solution it was obvious that there is no single
tile that can be used for all purposes: too different were the demands on the visual requirements. The solution had to
be a modular construction kit, which allows users to combine different tile modules on a pre-defined layout.

The question remained how to create a uniform design of these modules and the whole tile. Here we were able to
draw on the great work of John Armitage: his design proposals for analytical tiles were our aesthetic standard for a
consistent style. For further reading take a look at his book “Bringing Numbers to Life: Lava and Design-Led
Innovation in Visual Analytics”.

For our  extension Design Studio 1.6 SP06 or higher or Lumira Designer >= 2.0 and IE 11+ aregraphomate tiles
required. For further information, for example about the deployment on the Business Intelligence Platform (BIP) or
SAP Netweaver, please consult the Product Availability Matrix (PAM). Please note that from 2017, we will no longer
support Internet Explorer 9 and 10.

In the sense of a uniform language regulation we speak in the further manual of Lumira Designer or briefly
Designer. Our products are still compatible with SAP Design Studio 1.6.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Installation

Local installation of the extension to Designer

You have installed Designer 2.0 SP00+ on your computer.

Save the zipfile  to a folder of your choice.graphomate_tiles2.x.x.zip
In Designer, choose  click on  and select the zipfile whichTools  Install Extension to Lumira Designer, Archive
has been saved before.
Choose  to start the installation.Finish
Choose  and again  to confirm the installation.Next Next
Accept the terms of the license agreement and choose .Finish
Choose  to allow a restart of Designer.Yes
After the restart, the graphomate extension appears in the Component View of Designer.

Removing the extension from Designer

In Designer choose ….Help > About

Click the  button.Installation Details
Select the component graphomate tiles 2.x.x
Choose … .Uninstall
In the UninstallWizard choose .Finish
Choose  to allow Designer to restart.Yes

Before opening your old dashboards/BI apps with Designer 2.0, you need to migrate them to m mode
with Design Studio 1.6.
Our extensions for Design Studio 1.6 will also run in Designer 2.0. When starting Lumira 2.0
Designer, please do not import our graphomate extension from SAP Design Studio 1.6. Instead we
suggest using the versions specifically built for Designer 2.0.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Server installation of the extension

Users need to deploy the locally installed extension to the BI platform before launching the fromgraphomate tiles 
the BI platform.

Choose in the BI Platform Mode Tools > Platform Extensions.
Select the extension  that is installed on your local computer.graphomate tiles
Choose Install on Platform.
Manually restart the BI Platform Adaptive Processing Servers that host the Analysis Application Service and
accept the warnings in Designer.
The graphomate extension appears under Extensions Installed on Platform.
Choose .Close
Again restart the BI Platform Adaptive Processing Servers that host the Analysis Application manually.

Uninstalling the extension from the Server

Choose in the BI Platform Mode Tools > Platform Extensions.
Choose the .graphomate tiles
Choose Uninstall from Platform.
Confirm the uninstalling by choosing .Yes
In order to complete the uninstalling process, manually restart the BI Platform Adaptive Processing Servers
that host the Analysis Application Service and accept the warnings in Designer.
The  tiles is then removed from the graphomate Extensions Installed on Platform.
Choose .Close
Manually restart the BI Platform Adaptive Processing Servers that host the Analysis Application Service.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Quick Start

You have defined a Data Source and now want to depict Data Series from this query with modules of the graphomat
.e tiles

Drag the component  to the canvas and bind the Data Source to this component viagraphomate tiles
drag&drop. Unfortunately, it is only possible to assign one Data Source per tile (as for all Designer
components).

Now you can configure your tile on the  tab: To do this, first select a layout and afterwardsGeneral/Layout
choose the desired modules and drag and drop them to the Builder. The properties for each module are then
generated in the background. You can adjust the properties on the next tab Modules.

There you can select via  which dimensions and measures from the data source shouldDisplayed Dimensions
be displayed in the modules. This option is strongly related to the chosen module (some modules do not
require the visual display of dimensions).

Via the  tab you determine the comprehensive number format for the tile.Appearance

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Properties

Basically, you have two ways in which to change the properties of :  graphomate tiles
Using the  , that shows all the parameters in a structured list or via the Standard Properties Sheet Additional

. The latter offers a more user-friendly Interface. Properties Sheet

The check boxes   in front of properties in the   are used to control the visibility ofAdditional Properties Sheet
elements and activation of functions. The data source to be used can only be assigned via Drag&Drop to the
component or to the   under  .Standard Properties Sheet Data Binding

By pressing the F5 key, both the range of characters as well as the Additional Properties Sheet can be
reinitialized. This is sometimes necessary when changes in the properties are not adopted directly in the
character range.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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General/Layout Tab
Modules

Here you can see a list of all currently available modules that can be used to design your tiles. The range of
modules is constantly growing with new releases of the graphomate tiles. A detailed guidance on each module and
its options can be found in the description of the Modules tab.

The Lines Module visualizes trends and thresholds
with two lines.

The Bullet Graphs Module shows up to five bullet
graphs after Stephen Few's concept.

With the Pies Module you can visualize percentages
and a deviation in a pie chart.

The Sparklines Module displays up to ten small,
individually scaled line charts.

The Title Module allows a data-driven definition of
two title lines and an icon.

The Column Module shows up to three columns with
data labels.    

The Column Module displays up to three different 
measures including category labels and values. 

The Footer shows a measure with labels in one line.

The KPI Module visualizes a measure as large
number.

The Legend Module shows up to three items for a
color-based legend.

The Bars Module shows analogous to the Columns
Module up to three bars with data labels.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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The Stacked Column Module shows a data series as
a stacked chart.

The Table Module displays texts and figures in form
of a list.

The Waffles Module displays up to two data series
as a segmented bar chart.

The Slopegraphs Module visualizes up to three
DataCellLists and shows the trend of the ranking of
the individual data points.

The Icon Module displays a single icon.

The Text Module displays up to three lines of fully
HTML capable text.

Layout Config

This switch can be used to select the face of the tile
to be configured.

Each face has its own configuration. This extends to
modules, databinding, layout as well as layout
options. However, only a single data source is
permitted per tile.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Via mouse click you can choose from currently 24
different layouts that consist of up to three lines and
two columns. To set a certain layout just click on the
little grey icon; it then turns blue and the available
layout slots are displayed beneath.

Then simply drag one of the modules above to the
desired row or column of the Builder and drop it
there.

According to the selected module, data connection
and available options are generated in the
background and displayed on the Modules tab.

Please bear in mind that Design Studio allows only
one data source per tile.

Already selected modules can be moved within the L
 via drag and drop. Assigned data andayout Builder

other settings are retained.

Modules can be deleted using the button with the
little x in the top right corner of the module icons.

Layout Display Options

Depending on the chosen layout different options
are available here.

For example, the height ratio of the rows to each
other can be adjusted. (A selection of 1:1:1 results in
identical heights of the three rows).)

For layouts that contain more than one column,
there is also the option to adjust the width ratio of
the columns to each other. (A selcection of 1:1
results in identical widths of the two columns.)

The option  activates thin dividingShow Divider Lines
lines between the rows of the layout.

Adjust the thickness of these dividing lines via Divide
.r Thickness

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Module Padding allows you to set a uniform distance
that affects each individual module (green highlight
in the figure on the right shows the default setting of
5 pixels). The Padding at this point has no effect on
the dividing lines; for this use the Component
Padding on the Appearance tab (blue highlight).

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Modules Tab

On this tab, data from the chosen data source can
be assigned to the selected modules. The contents
of this tab is generated from the modules chosen on
the  tab.Layout

Due to the dynamic nature of the tiles, the available
script commands to control the behavior of the
modules are generated only after the module
selection.

The script commands can be found by clicking on
the icon. A popup will appear from which the
available commands can be marked and copied with
the mouse. Clicking in the Additional Property Sheet
outside the popup will let it vanish.

By clicking on the dropdown menu, you can choose
the Displayed Dimensions from the metadata to be
used in the module.

Due to the modular system of a graphomate tile, every datapoint or datalist is andicated with a number. The
numbers of 'dataSingleCellx' or 'dataCellListx' in your  can differ to theAdditional Properties Sheet
screenshots in this User Manual. Please be aware.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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With a click on  , you can select data from the
data source to be used with the module. A click on 

 will delete the selection.

To easily identify the assigned data property, its
name is displayed in brackets after the dimensions
of the current selection (e. g. dataSingleCell2).

In certain modules (e. g. Title Module, Footer
Module), these can be addressed via a set of
wildcards. The following wildcards are available:

[DIMENSIONS] – shows all dimensions

[DIMENSIONn] – shows the n-th dimension (up to
DIMENSION6)

[SCALE] – shows the scaling factor

[UNIT] – shows the unit

[VALUE] – shows the value of a single data cell

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Bar Module

Use the  to display up to three different measuresBar Module
including category labels and values. The categories
displayed correspond to the selected .Display Dimensions

Max. Bar Height and  govern the behaviorMax. Label Height
of the module when the tile is resized; bars and labels will
scale up to the determined heights in pixels

If the option  is activated, the labels doAbsolute Label Height
not scale with the size of the tiles; instead the entry in Max.
Label Height is used as the font size.

Scaling Helper will display a help line at the specifiied Scaling
Helper Value.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Bullet Graph Module

The  corresponds to our graphomateBullet Graph Module
bullet graphs extension. It is based on Stephen Few’s
conceptual considerations regarding the display of KPIs.

A detailed description of all parameters would go beyond the
scope of this chapter. We’d like to refer you to the full
documentation of the graphomate bullet graphs here: de/en.

The following options specifically apply to the graphomate
tiles:

The option  determines the first element in theStart Element
assigned data series to be displayed.

The dropdown box  governs the numberNumber of Elements
of bullet graphs to be displayed.

With the checkbox , the headers canDisplay Category Labels
either be shown or hidden.

Suppress Sums excludes all sums from the selected data
series.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Column Module

Use the  to display up to three differentColumn Module
measures including category labels and values. The
categories displayed correspond to the selected Display
Dimensions.

Max. Column Height and  govern theMax. Label Height
behavior of the module when the tile is resized; bars and
labels will scale up to the determined heights in pixels

If the option  is activated, the labels doAbsolute Label Height
not scale with the size of the tiles; instead the entry in Max.
Label Height is used as the font size.

Checking will display a help line at the Scaling Helper 
specifiied .Scaling Helper Value

Category Labels in more than one row are possible with the
option .Multi Line Category Labels

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Column Series Module

Use the  to display up to three differentColumn Module
measures including category labels and values. The
displayed categories correspond to the selected Display
Dimensions.

Max. Column Height and  govern theMax. Label Height
behavior of the module when the tile is resized; bars and
labels will scale up to the determined heights in pixels

If the option  is activated, the labels doAbsolute Label Height
not scale with the size of the tiles; instead the entry in Max.
Label Height is used as the font size.

Checking will display a help line at the Scaling Helper 
specifiied .Scaling Helper Value

If the  option is activated, theMulti Line Category Labels
category labels are wrapped so that they are positioned one
below the other.

With  you determine the value from which youStart Element
want to display the values from your data source.

With  you can specify how many barsNumber of Elements
are to be displayed. You can display at least one or a
maximum of five.

The color of the labels of the integrated deviations
can be changed on the Appearance Tab under Color

.Configuration

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Footer KPI Module

This module is used to display a single KPI (Measure)
together with its metadata

If an accompanying  is chosen, theComparative Measure
deviation between these two can be displayed, either as
absolute value or percentage. This can be set with the Value

 option.Display

You can also use the manual input of values (Manual
 and ); these fieldsMeasure Manual Comparative Measure

override the values from the data assignment.

The input in  is shown in front of the measure. TheText Input
metadata from the data source can be inserted in the text
fields with wildcards; by default all dimensions are displayed
in this module.

The checkbox  governs whether positiveIncrease is Good
deviations will be displayed in red or green.

Units and  will display or hide unit or scalingScaling Factor
factor from the data source.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Free Text Module

The Free Text Module shows up to three lines of plain text.
Wildcards can be used to extract and display metadata.

The input boxes  take one line of text each.Text Line x

Fontsizes per row can be adjusted with the properties Fontsiz
.e Line x

For bold formatting, the checkbox  needs to beBold Titles
activated.

If the checkbox  is activated, texts exceeding theWrap Texts
space limit will be wrapped, resulting in several lines of texts.
Otherwise, they will be abbreviated with "...".

The dropdown boxes  and Vertical Position Horizontal
 influence the positioning of the text lines within thePosition

module.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Icon Module

The Icon Module can be used to depict a single icon. This can
be chosen from 19 predefined SVG symbols or the full set of
SAP UI5 icons.

Use the dropdown box  to choose the desired icon.Icon

Icon Color governs whether one of the component-wide
colors a an individually configurable color is used. If "Neutral
Color" is chosen, the "Text Color 2" will be used.

The field  allows to insert an icon of the SAPUI5 Icon Id SAPUI
 library, for example, e00a for a synchronize button. To5

display the icon, select  under  and write theSAPUI5 Icon Icon
Icon ID into the appropriate field. 

Max. Size is the maximal size of the icon in px. If the slot is
too small, the icon is reduced in size proportionally.

The dropdown boxes  and Vertical Position Horizontal Position
influence the positioning of the text lines within the module.

In the icon explorer, the SAPUI5 icon ID could be
shown with a prefix for hexadecimal encoding. The id
needs to be entered without the prefix; please use e.
g. "e00a" instead of "&#xe00a".

https://graphomate.atlassian.net/wiki/x/H4CCAw
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KPI Point Module

The  displays a single measure. The size ofKPI Point Module
the number is scaled according to the available space.

The options correspond largely with those of the Footer KPI
; in addition, a  can be set. The size ofModule Max Font Size

the displayed number will not exceed the determined font
size.

The checkbox governs whether positive Increase is Good 
deviations will be displayed in red or green.

Units and will display or hide unit or scaling Scaling Factor 
factor from the data source.

The option  allows to place theMetadata Below Value
additional information below the value itself.

The option  gives the oppertunity to displayShow As Percent
a percentage sign in the size and display form of the units.

The option  gives the oppertunity toReplace Null with 0
replace zero values with a 0, if this is desired.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Legend Module

The  can be used to display up to three keysLegend Module
together with the assigned colors.

The keys ( ) can be either entered manually, or canEntry 1 to 3
be generated using the existing . If wildcards arewildcards
used, it is necessary to assign data first, so metadata are
available.

To hide a key, simply empty the input field.

The colors to be displayed can be defined either with the
dropdown boxes  (The colors themselves canColor Key 1 to 3
be changed on the Appearance tab.). Alternatively you can
choose own colors with the fields  (forCustom Color 1 to 3
these colors, choose  in the fields ).Custom Color Color Key

The checkbox  will format the keys in … well, bold.Bold Text

The position of the colored squares can be determined with
the option  If  is selected, no squares areColored Boxes. None
displayed, but the keys themselves are colored accordingly.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Line Chart Module
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The  allows the display of two data seriesLine Chart Module
as lines ( )dataCellListx; second value: Secondary Measure
and an additional  which can beFixed Value (dataSingleCellx),
used as threshold value.

The dropdown box  governs which measure(s) willThreshold
be used as threshold value. If a threshold is chosen, the
difference area between  and threshold willPrimary Measure
be displayed colored. Depending on the selection, either the
differential area between  and Primary Measure Secondary

 or  and  is colored.Measure Primary Measure Fixed Value

The thickness of all displayed lines can be changed with the
option Line Size.

If the option  is activated, and a Threshold Excess is Good Thr
 is chosen, the positve difference area is displayed ineshold

green, otherwise in red.

The option turns the chart into anPrimary Measure as Area 
area chart.

If activated,  displays the first and last value ofValue Labels
the assigned  at the start and end of the linePrimary Measure
chart.

Category Labels displays the selected dimensions below the
axis; this options works analogous to Show Value Labels.

Multi Line Category Labels break a label into several rows.

Value Axis displays a value axis on the left side of the line
chart.

During runtime,    displays small circlesVisible Click Handlers
around possible jump points, when the mouse pointer hovers
somewhere over the module.

Suppress Sums excludes all sums from the selected data
series. As only one data source per tile is possible, this option
can be useful if the sums are needed in another module, e. g.
the KPI Module.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Pie Module

The  displays a percentage including a deviation.Pie Module

The value for the circle is assigned with the optionCircle Data 
 ,  is used to(datasingleCell17) Arc Data (dataSingleCell18)

assign the the comparative measure, which is displayed as
circular segment.  shows aDeviation Data (dataSingleCell)
value as deviation from the .Arc Data

The options  and  can be usedCategory Labels Value Labels
to enhance the graph with metadata from the data source (Ca

) and exact values.tegory Labels

With the checkbox  the interpretationPos. Deviation is Good,
of the deviation can be changed; this way, negative deviations
can be displayed as positive.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Slopegraphs Module

The Slopegraphs module basically corresponds to our
extension . It visualizes up to threegraphomate slopegraphs
DataCellLists and shows the trend of the ranking of the
individual data points.

Number of Elements limits the entries to be displayed to a
maximum.

The entry in   determines with which element theStart Element
display of the slopegraphs begins. If 5 is entered here, the
first slopegraph is generated from the fifth line, lines 1-4 are
skipped.

Suppress Sums excludes any totals in the data source from
the display.

Trend shows the trend of the connecting lines by coloring
them.

Negative is Good inverts the colors of the trend lines.

The thickness of the lines can be set using the Slope
property.Thickness 

The  option can invert the sorting sequence.Ascending Order

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Sparklines Module

The  largely corresponds to our Sparklines Module graphomat
 component. It visualizes up to ten data series ase sparklines

"word-sized graphics". As per default, the  Sparklines Module

uses the full result set as data input; however, with the  bu
tton, a smaller selection can be made. Minimum and
maximum in each sparkline are depicted as red/green dots.
Each individual sparkline is scaled to its own minimum and
maximum; the two grey bars in the background of the
sparklines give orientation aid where the depicted data is
located in the overall data set. In the example above, the data
for Arkansas ist located in the upper third of the result set,
whereas Alabama and Alaska are located near the bottom.

Number of Elements This options governs the number of lines
of data that are used to generate sparklines.

The entry in governs the first element in theStart Element 
input data to be displayed. If e. g. a 5 is entered, the first
sparkline is generated from the fifth line of data, lines 1 to 4
are left out.

With the option , category labels in front ofCategory Labels
the sparklines can be toggled on or off.

Suppress sums excludes sums from the data to be displayed.

Data in Rows governs whether the input result set is
interpreted in rows or columns.

https://graphomate.atlassian.net/wiki/x/H4CCAw
https://graphomate.atlassian.net/wiki/spaces/GSE/pages/71401556/User+Manual
https://graphomate.atlassian.net/wiki/spaces/GSE/pages/71401556/User+Manual
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Stacked Column Module

Use the  to display a data series as aStacked Column Module
stacked chart. The categories displayed correspond to the
selected Displayed Dimensions.

Column Width, Max. Label Height and  Absolute Label Height
work analogous to the  or Columns Bar Module.

If the option  is activated, the stack elementsGraded Colors
are no longer colored monochrome with white dividing lines,
but as color gradations of  (defined on the Data Color 1 Appea

).rance Tab

If  is activated, and the connected data seriesNegative Stacks
contains negative values, these are sorted to be at the bottom
of the stacked bar. In addition, a small indicator is displayed
at the baseline.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Table Module

The  can be used to display several measuresTable Module
in a tabular form, either as absolute values or percentage (Val

).ue Display

Color Display governs the text color of the table.

The option  can be used to determine the firstStart Element
element in the data series to be displayed. If e. g. a 5 is
entered, the table starts with the 5th element in the data
series; elements 1 to 4 are skipped.

Number of Elements narrows the displayed elements to the
number entered.

With  the maximal font size is determined; upMax. Font Size,
to this value (in pixels), the text will scale with the tile.

If the options  or  are active, the table willUnits Scaling Factor
show these preceding the first value, provided they are
contained in the data source.

For ease of reading, the option Alternating Background  Color
can be used to toggle light-grey bars in the background of
every other line.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Title Module

The  is text component with either one or twoTitle Module
rows, and an optional icon.

As described above, the metadata from the data source can
be inserted in the text fields with wildcards; alternatively, the
texts can be entered manually.

For bold formatting, the checkbox  needs to beBold Titles
activated.

If the option  is activated, both lines ofAbsolute Label Height
text use the global fontsizes (Appearance Tab). If the option is
deactivated, the text size is scaled down if necessary.

If the checkbox  is activated, texts exceeding theWrap Titles
space limit will be wrapped, resulting in several lines of texts.
Otherwise, they will be abbreviated with "...".

The Icons to be displayed in the right of the module, as well
as their color, can be set either manually or via scripting. To
choose manually, select the desired icon from the dropdown
box. The size of the displayed icons scales with the font sizes
of title and subtitle. These can be set in the .Appearance tab

The field  allows to insert an icon of the SAPUI5 Icon Id SAPUI
 library, for example, e00a for a synchronize button. To5

display the icon, select  under  and copy theSAPUI5 Icon Icon
Icon ID into the appropriate field.

In the dropdown box with the label  youHorizontal Position
can select how the title should be displayed: either left-aligned
(standard), center-aligned or right-aligned.

If is deactivated, the option Absolute Label Height Wr
 is ignored; also, inline HTML tags will not beap Title

interpreted.

In the icon explorer, the SAPUI5 icon ID could be
shown with a prefix for hexadecimal encoding. The id
needs to be entered without the prefix; please use e.
g. "e00a" instead of "&#xe00a".

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Waffle Module

The depicts up to two data series asWaffle Module 
segmented stacked bars ("waffles").

The option toggles the display of theValues Labels 
underlying values.

With , category labels can be toggled on orCategory Labels
off.

Number of Elements This options governs the number of lines
of data that are used to generate waffle bars.

The entry in governs the first element in theStart Element 
input data to be displayed. If e. g. a 5 is entered, the first bar
is generated from the fifth line of data, lines 1 to 4 are left out.

Suppress sums excludes sums from the data to be displayed.

The option governs whether the bars areAxis Alignment 
aligned with the left component border ("Leftbound"). If
"Center" is chosen, the 0-axis is located in the center; in this
case, the bars will be drawn from the center to the left and to
the right.

With the option the interpretation of theCalculation Base, 
input data as either absolute or percentual is determined.

The value  is only used if "Absolute" is chosenUnits per Box
as . It is used as calculation basis for aCalculation Base
single box in the waffle pattern. If e. g. a value of 4500 is to be
depicted, and 100 is specified as the bar willUnits per Box, 
contain 45 little squares; an input of 1000 results in 4.5
squares.

The value in  is applied if "Percentage" isPercent per Box
chosen as . In this case, the sum of bothCalculation Base
data series for each pair of bars is interpreted as 100%; an
input of 1 results in 100 boxes for both series, an input of 5
results in 20 boxes for both series.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Appearance Tab

Font Sizes

In this section, the  used throughout thefont sizes
tiles component can be adjusted. All inputs are in
pixels. Likewise, the  can be changedfont family
here.

Padding

The padding defined here affects the space between
the border of the overall component and the
modules contained within (blue frame in the picture
on the right). Thus, it also effects the divider lines
between the modules. Individual module paddings
can be adjusted on the  tab.General/Layout

Border Size

This property governs the border size of the
component. If a border size of 0 is specified, no
border will be displayed.

Grid

The option  activates a grid function; ifSnap to Grid
checked, the size of the drawing area can only be
changed in the intervals determined in the Grid Size
input field.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Value Format

In this section, the format of all value labels is
determined:

Basic
Here, you can change the presets for absolute
and percentage value according to numeral.js.

 changes the country setting. If set to Locale AUT
 the country setting will be governed by theO,

data source.
Extended
If a fixed format is desired for the value labels,
this can be done with the extended number
format. The resulting format string can be set via
scripting as well. See Number Formatting

Color Configuration

The general color configuration is defined in this
section. In this way, the consistent appearance of all
modules in a given tile is ascertained. Adjustable are
the colors for  and   valuGood(positive) Bad(negative)
es  two  colors and two  as well as, text Data colors
the color of the C  which alsoomponent Border
affects the slot divider lines. The Component

 fills the entire tile and the color for Background Hove
shows up while hover over the tiler .

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Behavior Tab

Scaling

In this section, the scaling mode can be changed. If
set to Auto, each module will be scaled according to
the minima and maxima of the selected module;
scaling will usually start at 0. The setting Manual
enables you to enter particular minimum and
maximum values.

If the scaling is set to Auto, the tile can be registered
in a Comparison Group by activating the checkbox.
If active, the Comparison Group will govern scaling;
all components within this comparison group will be
scaled identically and an indicator of the comparison
group is shown during design time.

Within the BIApp, comparison groups are used
globally, i. e. graphomate tables, graphomate charts
and graphomate bulletgraphs which are part of the
same comparison group will be scaled identically.

Note: pie modules are scaled according to their
surface and are not compatible to other modules
and or components within the same Comparison
Group. Therefore It is advisable to use a separate
Comparison Group for tiles containing pie modules.

Flip Effect

In this section, the flip effect of the tile can be
configured.

The control element beneath can be used to select
the desired flip action.

Flip Duration governs the animation duration in
milliseconds. If e. g. a 1000 is entered, the animation
will last for one second.

If the flip effect should only be triggered on a specific
module, this can be realized with a small script in the

 event:On Component Selected

if (GRAPHOMATETILE_1.getSelectedModule(
) ==
1){GRAPHOMATETILE_1.toggleFlip();}

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Server Tab

Server Configuration

Here you can enter the to which the Server URL 
component should connect and from which it should
retrieve the templates.
If you have specified the URL to the server, a check
mark indicates that a connection could be
established.
If another server is used later, you can also press
the button next to the Save button and edit the Serv

.er URL

The hyperlink below the buttons allows you to jump
to the admin panel.

Templating Configuration

If the current settings are to be saved as a template,
a new template name can be entered in the input
field with the name and confirmed Create Template 
by clicking the button. If the Save current State 
naming convention entered is correct, the template
is saved on the server and a toast with the
corresponding message is displayed in the lower
part of the Additional Property Sheet. However, if the
name entered does not meet the expected naming
conventions, a toast with the permitted characters is
displayed accordingly.

Templates stored on the server can be retrieved and
applied via the Template List. Just select the desired
template and press the button. If you want to Apply 
delete a template, select the template in the list and
press the button. If changes have been made Delete 
to the templates on the server side, the list must be
updated via the button. Changes should Refresh List 
then be visible.

See Server Properties.

https://graphomate.atlassian.net/wiki/x/H4CCAw
https://graphomate.atlassian.net/wiki/spaces/GMSE/pages/658374808/Properties
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Search Tab

Search Tab

At this point you can search for the name, function
or group of a property which are displayed at the Ad

. The appropriate settingsditional Properties Sheet
are then displayed directly and can be changed
here.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Info Popup and Server Connection Indicator

This section contains information about the installed
version of  as well as a link to agraphomate tiles
feedback form on our website.

The Credits contains an overview of the used
libraries.

The icon next to the Info Popup button will indicate if
the connection to the graphomate server is 
successful. In this case it will be in green color. Else
it will be grey.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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Number Formatting
Possible Input for The numeral.js Format String

Floating point

Number Format String Output

10000 '0,0.0000' 10.000,0000

10000.23 '0,0' 10

-10000 '0,0.0' -10.000,0

-0.23 '.00' -,23

-0.23 '(.00)' (,23)

0.23 '0.00000' 0,23000

0.23 '0.0[0000]' 0,23

1230974 '0.0a' 1,2m

1460 '0 a' 1 k

1 '0o' 1st

Currency

Number Format String Output

1.000.234 '$0,0.00' $1.000,23

1000.2 0,0[.]00 $' 1.000,20 $

1001 '$ 0,0[.]00' $ 1.001

Percentage

Number Format String Output

1 '0%' 100%

-0.43 '0 %' -43%

Source 

https://graphomate.atlassian.net/wiki/x/H4CCAw
http://numeraljs.com/
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Possible Input for The Extended Number Format String

Percentages and absolute numbers are formatted separately. For this two format strings are used, which follow the
same rules and structure. In general the strings of characters in the format string are simply replaced in the input
number. Exceptions to this rule would be scaling factors and the number of decimal places. 

The elements of the format string are separated by the "|" character. Format strings with less than 7 elements (or 6
"|" characters) are considered invalid and therefore ignored. In this case the standard format without scaling and with
one position after the decimal point is used.

The format string consists of the following elements, the ordering is obligatory and cannot be changed:
| | | | | |Negative Prefix Thousands Decimal Scaling PointsAfterDecimal Suffix

Negative The prefix for negative numbers. The string "()" will result in the number placed inside
parentheses, including eventual prefixes and suffixes. If   is used, the absolute numberNone
will be shown.

Prefix A prefixed string of characters, for example a currency symbol or an identifier for the scaling
factor.

Thousands A separator for thousands.

Decimal A separator for the decimal places.

Scaling The scaling factor for the value. This can be given as a whole number or a power, formatted
as   A whole number will be calculated as a power to the basis 10 internally. In case of an^m.
given power the value will be divided by it directly. Even negative numbers are possible, for
example "-3" or "10^-3"; in this case the value will get adequately higher. Non numeric
inputs are ignored.   given a "0" or a "1" will result in a scaling factor of 1. ThePlease note:
only way to achieve a scaling by 10 is to set the input to "10^1".

PointsAfterDecimal The number of places after the decimal.

Suffix A suffix for the value, analogous to the prefix.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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CSS Selectors

Overview of css classes

The following illustrations provides some of the css selectors, which can be adressed by using the   inCostum CSS
SAP Lumira Designer.

https://graphomate.atlassian.net/wiki/x/H4CCAw
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